Wind resource assessment using the WAsP software

Mortensen, Niels Gylling

Publication date:
2018

Document Version
Publisher's PDF, also known as Version of record

Link back to DTU Orbit

Citation (APA):
46200 Planning and Development of Wind Farms: Wind resource assessment using WAsP software

Niels G. Mortensen

DTU Wind Energy E-0174

December 2018
Summary (max 2000 characters):
These course notes are intended for the three-week course 46200 Planning and Development of Wind Farms given each year at the Technical University of Denmark. The purpose of the course notes is to give an introduction to wind resource assessment and siting issues using the WAsP (version 12) suite of programs.
Contents

1 Introduction 5
   1.1 Observation-based wind resource assessment 6
   1.2 Numerical wind atlas methodologies 7
   1.3 Wind resource assessment procedure 8
   1.4 Energy yield assessment procedure 9

2 Meteorological measurements 10
   2.1 Design of a measurement programme 10
   2.2 Quality assurance 10

3 Wind-climatological inputs 11
   3.1 Wind data analysis 11
   3.2 Observed wind climate 12

4 Topographical inputs 13
   4.1 Elevation map 13
   4.2 Land cover map 14
   4.3 Sheltering obstacles 16

5 Wind farm inputs 16
   5.1 Wind farm layout 16
   5.2 Wind turbine generator 17

6 WAsP modelling 17
   6.1 Modelling parameters 18
   6.2 WAsP analysis 20
   6.3 WAsP application 20
   6.4 Validation of the modelling 21
   6.5 Special considerations 24

7 Additional technical losses 25

8 Modelling error and uncertainty 26
   8.1 Prediction biases 28
   8.2 Sensitivity analysis 28
   8.3 Uncertainty estimation 29

9 Wind conditions and site assessment 30
   9.1 Extreme wind and turbulence intensity 31
   9.2 IEC site assessment 32
   Windfarm Assessment Tool (WAT) 33

References 33

Acknowledgements 35

A WAsP best practice and checklist 36

B Note on the use of SAGA GIS 38

C Digitisation of the land cover (roughness) map 42

D The Global Wind Atlas 43
46200 Planning and Development of Wind Farms

The general course objectives, learning objectives and contents for DTU 46200 are listed below for reference. The full course description is given in the DTU Course Catalogue. The present notes are related to the wind resource assessment and siting parts only.

General course objectives

The student is provided with an overview of the steps in planning and managing the development of a new wind farm. The student is introduced to wind resource assessment and siting, wind farm economics and support mechanisms for wind energy. An overview of the various environmental impacts and societal challenges from wind farms is offered.

Learning objectives

A student who has met the objectives of the course will be able to:

- Describe the methodologies of wind resource assessment and their advantages and limitations.
- Explain the steps in the selection of a site for measurement of the wind resource and good practice for measurement of the wind resource.
- Calculate the annual energy production using the WAsP software for simple wind farm cases in terrain within the operational envelope of the WAsP model.
- Identify and describe factors adding to the uncertainty of the wind resource and wind farm production estimates.
- Estimate the most important key financial numbers of a wind project and explain their relevance.
- Identify the main environmental impacts from a wind farm and suggest mitigation measures.
- Explain the three most common policy tools for support of wind energy projects
- Explain the steps in the development of a wind farm with a balanced emphasis on the annual energy production, wind turbine loads, economics, grid connection, environmental impact and societal context of a project.
- Explain the main steps in developing the grid connection of a wind farm.
- Carry out a simple stakeholder analysis and suggest appropriate engagement strategies.

Contents

An introduction to market, policy and support mechanisms relevant to wind energy. Wind resources and wind conditions: anemometry; design and siting of meteorological stations; wind distributions; observed, generalised and predicted wind climates; observational and numerical wind atlases, elevation maps and land cover, roughness classes and roughness maps; sheltering obstacles; wind farm wake effects, micro-scale flow modelling (WAsP), wind resource mapping; wind farm layout; wind farm annual energy production.

The procedure for obtaining an environmental permit for a wind farm. The various types of environmental impacts from a wind farm. Introduction to wind farm economics. Introduction to grid connection. The students will work in groups of 4. The group work will be documented in a report and will be presented orally by all course participants.
1 Introduction

Wind resource assessment is the process of estimating the wind resource or wind power potential at one or several sites, or over an area. One common and well-known result of the assessment could be a wind resource map, see Figure 1.

![Wind resource map](image)

*Figure 1. Wind resource map for Serra Santa Luzia region in Northern Portugal. (Image © 2009 DigitalGlobe. Data SIO, NOAA, U.S. Navy, NGA, GEBCO. © 2009 Cnes/Spot Image. Image © 2009 GeoEye).*

The wind resource map usually shows the variation over an area of the mean wind speed or power density, for a given height above ground level. While this may provide a good indication of the relative magnitude of the wind resource, a more realistic estimate is obtained when the sector-wise wind speed distributions are combined with the power curve of a given wind turbine to obtain a power production map, see Figure 2.

![Power production map](image)

*Figure 2. Power production map for a sample wind farm in Northern Portugal. (Image © 2009 DigitalGlobe. Data SIO, NOAA, U.S. Navy, NGA, GEBCO).*
The result of wind resource assessment is therefore an estimate of the mean wind climate at one or a number of sites, in the form of:

- Wind direction probability distribution (wind rose), which shows the frequency distribution of wind directions at the site, i.e. where the wind comes from,
- Sector-wise wind speed probability distribution functions, which show the frequency distributions of wind speeds at the site.

Wind resource assessment provides important inputs for the siting, sizing and detailed design of the wind farm and these inputs are exactly what the WAsP software provides.

When it comes to the siting of individual wind turbines, a site assessment (IEC 61400-1) is usually carried out. This will provide estimates for each wind turbine site of the 50-year extreme wind, shear of the vertical wind profile, flow and terrain inclination angles, free-stream turbulence, wind speed probability distribution and added wake turbulence. This additional information may be obtained by using the WAsP Engineering software.

1.1 Observation-based wind resource assessment

Conventionally, wind resource assessment and wind farm calculations are based on wind data measured at or nearby the wind farm site. The WAsP software (Mortensen et al., 2014) is an implementation of the so-called wind atlas methodology (Troen and Petersen, 1989); this is shown schematically in Figure 3.

![Figure 3. Wind atlas methodology of WAsP (Troen and Petersen, 1989). Meteorological models are used to calculate the generalised wind climatology from the measured data – the analysis part. In the reverse process – the application of wind atlas data – the wind climate at any specific site may be calculated from the generalised wind climatology.](image)

Note, that the WAsP software estimates the ‘WAsP gross’ and ‘WAsP net’ yields only (steps 1-7 in Figure 3); the post-processing steps (8-9) must be carried out separately. The wind farm assessment tool (WAT) contain simple tools to aid in these calculations.
As can be deduced from Figure 3, WAsP is then based on two fundamental assumptions: first, the generalised wind climate is assumed to be nearly the same at the predictor (met. station) and predicted sites (wind turbines) and, secondly, the past (historic wind data) is assumed to be representative of the future (the 20-y life time of the wind turbines). The reliability of any given WAsP prediction depends very much on the extent to which these two assumptions are fulfilled.

1.2 Numerical wind atlas methodologies

WAsP has become part of a much larger framework of wind atlas methodologies, which also encompasses mesoscale modelling and satellite imagery analysis. This framework has been developed over the last two decades at Risø and DTU (Frank et al., 2001; Badger et al., 2006; Hansen et al., 2007) in order to be able to assess the wind resources of diverse geographical regions where abundant high-quality, long-term measurement data does not exist and where important flow features may be due to regional-scale topography. Figure 4 is a schematic presentation of this entire framework.

<table>
<thead>
<tr>
<th>Mesoscale</th>
<th>Pre-processing</th>
<th>Modelling</th>
<th>Post-processing</th>
<th>Numerical WA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wind classes</td>
<td>Mesoscale model: e.g. KAMM, WRF, MC2, MM5 or similar.</td>
<td>Predicted wind climate</td>
<td>Mesoscale maps Database of results WAsP *.LIB files Uncertainties Parameters</td>
<td></td>
</tr>
<tr>
<td>Terrain elevation</td>
<td>Regional wind climate</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Terrain roughness</td>
<td>Predicted wind resource for selected terrain site coordinates</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input specifications</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Model setup</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Measurements</th>
<th>Met. stations</th>
<th>Wind data</th>
<th>Verification</th>
<th>Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Siting</td>
<td>Data collection</td>
<td>Meso- and microscale results vs. measured data</td>
<td>Best practices Courses and training</td>
<td></td>
</tr>
<tr>
<td>Design</td>
<td>Quality control</td>
<td>Adjust model and model parameters to fit data</td>
<td>Microscale flow model</td>
<td></td>
</tr>
<tr>
<td>Construction</td>
<td>Wind database</td>
<td>Satellite imagery (offshore sites only)</td>
<td>Wind farm wake model =&gt; Wind farm AEP</td>
<td></td>
</tr>
<tr>
<td>Installation</td>
<td>Wind statistics</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operation</td>
<td>Observed wind climate</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Microscale</th>
<th>Pre-processing</th>
<th>Modelling</th>
<th>Post-processing</th>
<th>Observational WA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wind speed distributions</td>
<td>Microscale model: Linearised, e.g. WAsP, MS-Micro or similar. Non-linear, e.g. CFD (Computational Fluid Dynamics).</td>
<td>Predicted wind climate</td>
<td>Microscale maps Database of results WAsP *.LIB files Uncertainties Parameters</td>
<td></td>
</tr>
<tr>
<td>Wind direction distribution</td>
<td>Regional wind climate</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Terrain elevation</td>
<td>Predicted wind climate</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Terrain roughness</td>
<td>Predicted wind resource for selected terrain site coordinates</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sheltering obstacles</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 4. Overview of state-of-the-art wind atlas methodologies (Hansen et al., 2007).

Wind resource assessment based on mesoscale modelling, the numerical wind atlas, can provide reliable data for physical planning on national, regional or local scales, as well as data for wind farm siting, project development, wind farm layout design and micro-siting of wind turbines. However, bankable estimates of power productions from prospective wind farms require additional on-site wind measurements for one or more years.

The present course notes thus describe mainly the ‘grey’, ‘green’ and ‘yellow’ parts of the diagram above, i.e. what is referred to as the observational wind atlas methodology. Different inputs to the WAsP modelling are described in Sections 2 to 5; the modelling itself is described in Section 6, and the modelling errors and uncertainties in Section 8. Section 7 lists the different types of additional losses in the wind farm and Section 9 contains a very brief cookbook approach to site assessment using WAsP Engineering.

In addition to the present course notes, the WAsP help system (Mortensen et al., 2014) contains a Quick Start Tutorial section which illustrates the essentials of the WAsP software user interface.
1.3 Wind resource assessment procedure

The descriptions above and in the remainder of these notes reflect closely the structure and terminology of the wind atlas methodology and the WAsP implementation of this. In more general terms, the steps in the initial wind resource assessment procedure can be illustrated as is shown in Figure 5.

Wind measurements are made at wind farm site(s) using met. mast(s); every 10 minutes all year round. These raw site wind data are converted into calibrated wind data by the data logging system, employing calibration expressions for each individual instrument.

The quality and integrity of the calibrated wind data are then assessed; e.g. by visual inspection of the time-series and by data analyses, as described in Section 3. Missing data may be substituted with values derived from other similar or redundant sensors.

The aim is to establish the most accurate, reliable and complete data set for the site mast. Next, this data set must be seen in the context of the long-term wind climate at the site and an adjusted data set representing the long-term climatology should be established.

The analyses so far are mostly carried out using the wind data time-series. When a data set representing the long-term climatology at the site has been established, this can be used to calculate the statistics of the wind climate: the distributions of wind speed and wind direction, as well as mean values, standard deviations and other statistics.

The last step in the wind resource assessment procedure shown in Figure 5 is to predict or estimate the long-term wind climates at the prediction sites, which are most often the turbine sites in a wind farm. The tool used for this step is a microscale flow model which has the ability to extrapolate the observed wind climate to the prediction sites.

There are several kinds of ‘prediction’ or ‘estimation’ at play here: first, we estimate what the wind climate has been like in the past at our site mast, by referencing our observations to a suitable long-term data set. Secondly, we try to predict what the wind climate has been like at our wind turbine sites, by extrapolating the observed wind climate from the met. mast to those sites.

Finally, we often (silently) make the assumption (and prediction) that the predicted wind climate is representative of what is going to happen in the future; say, the over the lifetime of the wind turbines.
1.4 Energy yield assessment procedure

We can focus on the energy yield assessment procedure in a similar way as above and identify the following steps (Figure 6):

1. **Site wind climate = Site wind data ± [long-term extrapolation effects]**
   Using a long-term extrapolation procedure, the site wind data are referenced and adjusted according to the long-term climatology of the area.

2. **Reference yield = Wind climate at hub height plus [power curve]**
   The reference yield is calculated using the predicted wind climate at hub height at the mast location and the site-specific wind turbine power curve. However, most of the time this step is surpassed and the gross yield is calculated directly.

3. **Gross yield = Reference yield ± [terrain effects]**
   Using a flow model, the observed wind climate at the mast site is transformed to the predicted wind climates at the wind turbine sites of the wind farm. The ‘flow modelling’ part of Figure 6 includes both vertical and horizontal extrapolations.

4. **Potential yield = Gross yield – [wake losses]**
   Using a wake model, the wake losses at each turbine site are estimated and subtracted from the gross yield. This corresponds to the WAsP ‘net yield’.

5. **Net yield = Potential yield – [technical losses]**
   The additional technical (operational) losses in the wind farm are subsequently estimated and subtracted from the potential yield to get the net yield value ($P_{50}$) at the point of common coupling (PCC).

6. **$P_{90}$ yield = $P_{50}$ yield – 1.282×[uncertainty estimate]**
   The aggregate uncertainty of the entire energy yield assessment process is estimated and the net yield may be adjusted to obtain a net value corresponding to a certain probability of exceedance, e.g. the $P_{90}$ value as shown above.

By dividing the prediction process into these steps we have isolated the different model calculation results and it is therefore fairly straightforward to compare different methods and models (Mortensen et al., 2012, 2015). Figure 6 illustrates the steps in the procedure.

![Figure 6. Overview of steps in the wind farm energy yield assessment procedure.](Image)

These steps and their definitions are not universally agreed or even used; however, IEC and Measnet working groups are addressing these issues at the moment.
2 Meteorological measurements

WAsP predictions are mostly based on the *observed wind climate* at the met. station site; i.e. time-series data of measured wind speeds and directions over one or several years that have been binned into intervals of wind direction (the wind rose) and wind speed (the histograms). Therefore, the quality of the measurement data has direct implications for the quality of the WAsP predictions of wind climate and annual energy production. In short, the wind data must be **accurate, representative and reliable**.

### 2.1 Design of a measurement programme

It is beyond the scope of these course notes to describe best practice for wind measurements in detail, but the aspects discussed below are particularly important.

If possible, the measurement programme should be designed based on a preliminary WAsP analysis of the wind farm site. Such design ensures that the measurements will be representative of the site, i.e. that the mast site(s) represent the relevant ranges of elevation, land cover, exposure, ruggedness index, etc. found on the site. In short, we apply the *WAsP similarity principle* (Landberg et al., 2003) as much as possible when siting the mast(s). This design analysis may conveniently be based on SRTM elevation data and land cover information from satellite imagery such as Google Earth.

It is equally important in the design stage to use an observed wind climate that resembles the wind climate that may be observed at the wind farm site; e.g. by using data from a nearby met. station or modelled data from the region. A representative wind rose is particularly valuable as this may be used to determine the design of the mast layout; e.g. the optimum boom direction is at an angle of 90° (lattice mast) or 45° (tubular mast) to the prevailing wind direction. The height of the top (reference) anemometer should be similar to that of the wind turbine hub height; preferably > 2/3 $h_{hub}$.

Anemometers should be individually calibrated according to international or at least traceable standards. Several levels of anemometry should be installed in order to obtain a high data recovery rate (above 90-95%) and for analyses of the vertical wind profiles. Air temperature (preferably at hub height) and barometric pressure should be measured in order to be able to calculate air density, which is used to select the appropriate wind turbine power curve data set.

It is extremely valuable – and sometimes required for bankable estimates – to install two or more masts at the wind farm site; cross-prediction between such masts will provide assessments of the accuracy and uncertainty of the flow modelling over the site. Two or more masts are also required in complex and steep terrain, where ruggedness index (RIX) and ΔRIX analyses – as well as WAsP CFD calculations – are necessary.

### 2.2 Quality assurance

For projects where the measurement campaign has already been initiated or carried out, it is important to try to assess the quality of the collected wind data, as well as to ensure the quality of any and all site data used for the analysis. A site inspection trip is required and should be part of any (commercial) WAsP study – whether it is a second opinion, due diligence or feasibility study.

A number of WAsP Site/Station Inspection checklists and forms exist for planning the site visit and for recording the necessary information. The positions of the met. mast(s) and turbine sites are particularly important. Bring a handheld GPS (Global Positioning Systems) if possible.
System) for the site visit and note down the projection and datum settings; change these if required. Determine the coordinates of all masts, turbine sites, landmarks and other characteristic points on site (repeated readings over several days increase the accuracy).

Documentation of the mast setup and site may be done by taking photos of the station and its surroundings \((12 \times 30^\circ\text{-sector panorama})\). Use a compass when taking the sector pictures. Download the GPS data and photographs to your PC as soon as possible (daily).

The characteristics of anemometers and wind vanes deteriorate over time and after one or a few years they may not operate according to specifications. An important part of operating a wind-monitoring mast is therefore to exchange the instruments at regular intervals, as well as rehabilitating and recalibrating instruments in stock.

### 3 Wind-climatological inputs

The wind-climatological input to WAsP is given in the *observed wind climate*, which contains the wind direction distribution (wind rose) and the sector-wise distributions of mean wind speed (histograms), see Figure 7. The observed wind climate file should also contain the wind speed sensor (anemometer) height above ground level in metres and the geographical coordinates of the mast site: latitude and longitude. The latitude is used by WAsP to calculate the Coriolis parameter.

![Figure 7. Sample observed wind climate from Sprogø 1977-99; wind rose to the left and omni-directional wind speed distribution to the right (data courtesy of Sund & Bælt).](image)

Wind speeds must be given in metres per second \([\text{ms}^{-1}]\) and wind directions in degrees clockwise from north \([^\circ]\), i.e. from 0° (north) through 360°. The wind direction indicates the direction from which the wind blows. The observed wind climate is usually given for 12 sectors and the wind speed histograms using 1 m/s\(^{-1}\) wind speed bins.

#### 3.1 Wind data analysis

The wind data analysis and calculation of the observed wind climate may conveniently be done using the *WAsP Climate Analyst*. Whether the wind data are measured by the organisation carrying out the analysis or by a third party, a number of data characteristics must be known, such as: the data file structure, time stamp definition, data resolution (discretisation), calm thresholds, and any flag values used for calms and missing data. This information may be collected by filling out a WAsP Data Description Form; in the subsequent analysis all input values in the Climate Analyst should correspond to the data specifications.

In the Climate Analyst, the time traces of wind direction and speed, as well as a polar representation of concurrent data, can be plotted and inspected, see Figure 8.
The Climate Analyst checks the time stamps and observation intervals upon input of each data file, and also checks for missing records in the data series. However, the main quality assurance (QA) is done by visual inspection of the time series and polar plot, as well as the resulting observed wind climate. Things to look out for are e.g.:

1. Are there any spikes or sudden drops in the data series?
2. Are there periods of constant data values in the data series?
3. Are there periods of missing data in the data series?
4. Are there any unusual patterns in the data series?
5. Are there any unusual patterns in the polar scatter plot?
6. Do the wind speed time traces follow each other for different anemometers?
7. Do the wind direction time traces follow each other for different vanes?
8. Do the measured and Weibull-derived values of $U$ and $P$ compare well?
9. Does the calm class (0-1 ms$^{-1}$) in the histogram look realistic?

Finally, the observed wind climate is calculated and exported to an OWC file. The OWC file can subsequently be inserted into the WAsP hierarchy, as a child of a meteorological station member.

### 3.2 Observed wind climate

The observed wind climate (OWC) should represent as closely as possible the long-term wind climate at anemometer height at the position of the meteorological mast. Therefore, an integer number of full years must be used when calculating the OWC, in order to avoid any *seasonal bias*. For the same reason, the data recovery rate must be quite high (> 90-95%) and any missing observations should preferably be distributed randomly over the entire period.

Wind data series from prospective wind farm sites rarely cover more than one or a few full years, so they must be evaluated within the context of the long-term wind climate, in order to avoid any *long-term* or *climatological bias*. Comparisons to near-by, long-term meteorological stations or to long-term modelled data for the area can be made using simple (or complicated) measure-correlate-predict (MCP) techniques.
WAsP uses Weibull distributions to represent the sector-wise wind speed distributions and the so-called emergent distribution for the total (omni-directional) distribution. The difference between the fitted (and emergent) and the observed wind speed distributions should therefore be small: less than about 1% for mean power density (which is used for the Weibull fitting) and less than a few per cent for mean wind speed.

## 4 Topographical inputs

The topographical inputs to WAsP are given in a *vector map*, which can contain height contour lines, roughness change lines and lines with no attributes (say the border of the wind farm site). In addition, nearby sheltering obstacles may be specified in a separate *obstacle group*, which can be shown on the map too.

Map coordinates and elevations must be specified in meters and given in a Cartesian map coordinate system. The map projection and datum should be specified in the Map Editor so this information is embedded in the map file. All metric coordinates used in the WAsP workspace should of course refer to the same map coordinate system. Obstacle distances and dimensions must likewise be given in meters.

The Map Editor can do the transformation from one map coordinate system to another; the Geo-projection utility program in the Tools menu can further transform single points, lists of points and lists of points given in an ASCII data file.

### 4.1 Elevation map

The elevation map contains the *height contours* of the terrain, see Figure 9. These may be digitised from a scanned paper map – as described in the Map Editor Help facility – or may be obtained from a database of previously digitised height contours, established by e.g. the Survey and Cadastre of a country or region. Alternatively, they can also be generated from gridded or random spot height data using contouring software.

The elevation map should extend at least several (2-3) times the horizontal scale of significant orographic features from any site – meteorological mast, reference site, wind turbine site or resource grid point. This is typically 5-10 km. A widely cited rule for the minimum extent of the WAsP map is $\max(100 \times h, 10 \text{ km})$, where $h$ is the height of the calculation point above ground level; this is usually sufficient for the elevation map too.

The accuracy and detail of the elevation map are most critical close to the site(s), therefore it is recommended to add all *spot heights* within the wind farm site and close to the meteorological mast(s); one can also interpolate or digitise extra height contours if necessary. The contour interval should be small ($\leq 10$ m) close to calculation sites, whereas the contour interval can be larger further away from these sites ($\geq 10$ m).

Non-rectangular maps (circular, elliptic, irregular) are allowed and sometimes preferred, e.g. in order to reduce the number of points in the map, while at the same time retaining model calculation accuracy. There is no limitation to the size of the map, but the calculation time is proportional to the computer memory used for the map data.

The final elevation map should be checked for outliers and errors by checking the range of elevations in the map. An elevation map generated from a gridded data set could also be compared to a scanned paper map of the same area. If comparing the relief to Google Earth (GE), it should be borne in mind that the GE representation of the 3D terrain is usually much smoother than the WAsP representation.
Contour maps from gridded data

High-resolution gridded (raster) elevation data exist for many parts of the world, one such data set is derived from the Shuttle Radar Topography Mission (SRTM). The Map Editor can employ SRTM data directly for making elevation vector maps.

For other gridded data sets, it may be necessary to construct the height contours (vector map) from the raster data. One freely available software program that can be used to make WAsP vector maps from gridded data is described in appendix B: “A note on the use of SAGA GIS” (Conrad et al., 2015).

4.2 Land cover map

The land cover (roughness length) map contains a classification of the land cover, where each class/area is characterised by a specific land cover and roughness length value, $z_0$. These roughness change lines may be digitised from a scanned paper map, aerial photograph or satellite imagery as described in the Map Editor help facility. They may also be obtained from a database of previously digitised land cover, established by e.g. the Survey and Cadastre of a country or region. The Corine database covering the EU countries is an example of one such database, see Figure 10.

Internal boundary layer theory suggests that the roughness map should extend to at least $100\times h$ from any site – meteorological mast, reference site, wind turbine site or resource grid point – where $h$ is the height of the WAsP calculation. However, it turns out that this is not enough, and at least 50% are often added to this number. For a single wind turbine with a hub height of 80 m, the roughness map will therefore be about $25\times 25$ km$^2$. For a wind farm of 80-m turbines, the extent of the wind farm area should be added to this size. Likewise, the extent of any resource grid should be added.
Roughness lengths must be specified in meters and the roughness length of water surfaces must be set to 0.0 m in WAsP! This is because WAsP also uses this value as a flag value: ‘0 m’ indicates a water surface, whereas a small roughness length value means a smooth land surface (snow, sand, bare soil or the like).

The final roughness map should be checked systematically for errors, since these may give rise to erratic results in the WAsP calculations. Check the range of roughness length values in the main window of the Map Editor, and check for **dead ends** and **cross points** in the map display window (View > Nodes, Dead ends and Cross points). Some map editing may be needed to eliminate any dead ends and cross points.

When there are no more dead ends and cross points in the map, the consistency of the roughness values must be checked (View > Line Face Roughness errors) – there must be no **line face roughness (LFR) errors**! Finally, the roughness classification and values should be verified against a scanned paper map or by viewing the roughness change lines in Google Earth. The map may also be verified during a visit to the site.

All maps and images of the terrain are **snapshots** of the state of the terrain surface. The land cover and roughness length information used should of course correspond to the modelling scenario: use a historic (or present-day) map for modelling the meteorological mast(s) and use a present-day (or future) map for modelling the wind farm sites.

**Roughness maps from gridded data**

High-resolution gridded (raster) land cover data exist for many parts of the world. The current version of WAsP cannot employ such data directly, so it is necessary to construct the roughness change lines (vector map) from the raster data, e.g. using the Map Editor. There is currently no standard procedure for making vector roughness maps from raster land cover data; however, some techniques have been demonstrated using GIS systems or the WAsP Terrain Workshop. In addition, work is in progress to make the WAsP models use gridded elevation and land cover data directly.
4.3 Sheltering obstacles

Terrain features such as houses, walls, shelter belts, or a group of trees, that are quite close to the WAsP calculation site may be treated as sheltering obstacles and modelled using the shelter model of WAsP, see Figure 3. The following simple rule-of-thumb may be used to determine which model to use:

- If the point of interest (anemometer, turbine hub or other calculation point) is closer to an obstacle than about 50 obstacle heights \((H)\) and its height lower than about 3 obstacle heights – then treat the feature as a sheltering obstacle and use the shelter model.
- If the point of interest is further away than \(50H\) and/or higher than \(3H\), then treat the feature as a roughness element, i.e. adding to the roughness of the terrain.

5 Wind farm inputs

The wind farm inputs to WAsP consist of the layout of the wind farm (turbine site coordinates) and the characteristics of the wind turbine generator(s): hub height, rotor diameter and the site-specific power and thrust curves.

5.1 Wind farm layout

WAsP does not contain any advanced layout design tools, so the layout must be done free-hand or calculated in e.g. MS Excel. Turbine site coordinates may then be copied and pasted into WAsP. Free-hand layouts may be established quickly in the vector map by pressing the Ctrl-key and then dragging a turbine site (cloning) to a new turbine position. Distance circles around the turbine positions can be shown in the Spatial view as an aid in keeping a certain distance between the turbine positions.

![Figure 11. Sample wind farm layout in Zafarana, Egypt (Mortensen et al., 2005). The layout is mainly determined by the available land, the wind resource and aesthetics. Row 1-3 follow simple arcs, in which the positions were calculated using MS Excel; row 4 follow a terrain feature and the positions were originally drafted by hand.](image)
5.2 Wind turbine generator

It is important to use site-specific wind turbine generator data (i.e. power and thrust coefficient curves) when calculating the yield of the wind farm. WAsP 12 can interpolate or extrapolate to representative performance tables, if an Air density correction policy has been selected, see Figure 12. The basic data tables, corresponding to specific values of air density and/or noise level, must be obtained from the wind turbine manufacturer.

![Figure 12. Power and thrust curves for a sample Vestas V80 2-MW wind turbine. Different tables (lower left) may correspond to different air densities or sound levels. Inter-/extrapolation is done based on the selected Air density correction policy (right).](image)

6 WAsP modelling

Most WAsP studies in the past were carried out using the default parameters of WAsP. With version 12, air density for any site can be estimated automatically by WAsP from CFSR global reanalysis data (R. Floors, pers. comm.) and need not be input by the user anymore. The wind atlas structure should still be adapted because of the many masts and turbines with heights between 50 and 100 meters. Finally, more users have begun tweaking the heat flux values in order to better model the vertical wind profiles.

**Air density**

An estimate of the site air density must be made at any met. mast and wind turbine site in order to calculate a realistic wind power density and annual energy yield (AEP). The density of dry air can be calculated from measurements of atmospheric pressure and ambient air temperature at the site:

\[
\rho = \frac{B \times 100}{R \times (T + 273.15)}
\]

where \( \rho \) is air density (kg m\(^{-3}\)), \( B \) is atmospheric pressure (hPa), \( R \) is the gas constant for dry air (287.05 J kg\(^{-1}\) K\(^{-1}\)) and \( T \) is air temperature (°C).

If measurements of atmospheric pressure have not been carried out, the Air Density Calculator of WAsP can be used to estimate the dry air density from site elevation and the annual average air temperature at the site. A comparison of measured and WAsP-derived mean air densities for 10 sites in South Africa (Mortensen et al., 2014) and eight sites in NE China (Mortensen et al., 2010) is shown in Figure 13.
Figure 13. Measured and estimated mean air densities for 10 stations in South Africa (Mortensen et al., 2014) and eight stations in NE China (Mortensen et al., 2010).

In WAsP 12, a global model for air density has been implemented, see Figure 13. This is based on Climate Forecast System Reanalysis (CFSR, ver. 2) data from 2011-18 at a resolution of 0.5 degree (R. Floors, pers. comm.). The model includes the effect of air humidity and gives slightly lower (more correct) air densities. A performance table in the Wind turbine generator member of WAsP can then be estimated as described above.

6.1 Modelling parameters

A few modelling parameters may be changed at an early stage in the WAsP calculations: heights and roughness class values in the generalised wind climate.

Wind atlas structure

The generalised wind climate (wind atlas data set) is specified for five standard heights above ground level and five land cover (roughness) classes. These standard conditions should span the characteristics of all calculation sites in the project; WAsP is then able to interpolate between these conditions. However, the standard settings may also be adapted to the project in question.

The default heights in the WAsP wind atlas are 10, 25, 50, 100 and 200 m a.g.l. If the wind turbine hub heights or anemometer heights are somewhere between these values, one or more of these heights may be adapted to the project characteristics; e.g. 10, 20, 40, 62 and 100 m, see Figure 14. A maximum of five heights can be specified.

The default roughness classes in the wind atlas correspond to roughness lengths \( z_0 \) of 0, 0.03, 0.10, 0.40 and 1.5 m. If large parts of the terrain has a roughness length somewhere between or outside of these values, e.g. like the low values of many desert surfaces, one or more of these values may be adapted to the project. The standard conditions can be changed in the Project > Edit configuration for member… > Wind atlas structure.
Figure 14. Sample wind atlas data set where the heights are adapted to site conditions. Data courtesy of the Wind Atlas for South Africa (WASA) project.

**Atmospheric stability**

WAsP contains a stability model which employs separate mean and RMS heat flux values for over-land and over-water conditions; where over-water conditions are defined as areas of the vector map where the roughness length $z_0 = 0$ m. The default wind profile over land corresponds to slightly stable conditions and the wind profile over water to near-neutral stable conditions; the exact heat flux values are given in the WAsP project configuration.

Figure 15. Profile model tab in the Generalised wind climate window. Here, one can select the WAsP12 geostrophic shear model and adapt the heat flux values to the project.

The default heat flux values were originally determined for the European Wind Atlas (Troen and Petersen, 1989) but have also worked well for many other parts of the world. Note, that the heat fluxes are not identical to what can be measured using e.g. a sonic anemometer, but have the same qualitative meaning.
The mean (and rarely RMS) heat flux value may be adjusted to site conditions – in order to tweak the wind profiles slightly – but this should only be done following careful analysis and improvement of the elevation and land cover map. Furthermore, mast flow distortion might be evaluated and taken into account in the analysis. Since the WAsP heat flux values cannot be determined objectively (in the present version), they must be based on careful wind profile analysis, see Figure 18.

6.2 WAsP analysis

WAsP analysis is the transformation of the wind climate observed at a meteorological station to the generalised (also sometimes called regional) wind climate. A typical WAsP analysis as it appears the WAsP hierarchy is shown in Figure 15.

The generalised wind climate may be dynamic, as indicated in Figure 15 by the small mast in the icon; or static, if the wind atlas data set is simply a previously calculated data file. The dynamic generalised wind climate may contain a map, which is then specific to the met. station site. The met. station can contain an obstacle group, which is then specific to the met. mast. The map and obstacle group should of course correspond to the conditions in the time period when the wind measurements were taken. Dynamic generalised wind climates are preferred over static because they reflect changes directly.

![Figure 16. In the workspace hierarchy, the observed wind climate is always child of a met. station, which is always child of a generalised wind climate (wind atlas).](image)

6.3 WAsP application

WAsP application is the transformation of the generalised wind climate (wind atlas data set, GWC) to the predicted wind climate(s) at one or more sites, such as those of the turbine site, wind farm, reference site or resource grid members of the WAsP hierarchy. A typical WAsP application as it appears in the WAsP hierarchy is shown in Figure 16.

![Figure 17. The generalised wind climate, a terrain analysis with vector map, and a wind turbine generator are inputs to the application procedure; the turbine site, wind farm and resource grid contain the prediction results or outputs.](image)

While this setup is the most common, it is also possible for the Generalised wind climate to be a child of any of the calculating members shown in Figure 16, including a turbine site group. In this way, more masts (or more grid points from a mesoscale model) may be used at the same time for the predictions.
Wind farm
A wind farm consists of a number of wind turbines, which may be arranged in turbine site groups. The Park wake model is invoked automatically for the wind turbines in a wind farm; however, two or more 1st-level wind farms in the hierarchy do not interact. So, all the wind turbines that should be part of a given wake calculation must be in the same (1st level) wind farm. The wake models were designed for small and medium-sized wind farms where the distances between turbines are larger than 3-4D.

WAsP 12 comes with an updated default wind farm wake model, referred to as Park2 (Rathmann et al., 2018). This model features automatic determination of terrain context (onshore/offshore) and wake decay constant(s).

Reference site
The reference site member is used to relate wind farm power production to the wind speed and direction measured at a nearby mast, i.e. to establish a wind farm power curve.

Wind resource grid
The wind resource grid corresponds to a regular grid of wind turbines, but no wake calculations are done. The results for each calculation site correspond to the free-stream values of the wind climate and wind resource. Remember, that the map requirements mentioned above should be fulfilled for all the sites in a resource grid.

6.4 Validation of the modelling
In general, predictions are based on data from only one set of instruments – anemometer and wind vane – on one mast. While this is sufficient to perform the calculations and get some results, additional instruments on the same mast – and/or on another nearby mast – add significant value to a wind farm project.

The vertical wind profile
If wind speeds have been measured at two or more heights along the mast, it is possible to investigate whether WAsP is able to model the vertical wind profile at the site. This comparison may be used to adjust the terrain descriptions and also (sometimes) the atmospheric stability settings. The top anemometer is almost always used as the reference (and basis for the yield calculations) because flow distortion is the least here.

The procedure for evaluating the vertical wind profile is then:

1. Use the observed wind climate (OWC) from the reference anemometer to calculate the generalised wind climate (GWC).
2. Insert a Turbine site in the map at the location of the meteorological mast.
3. Set the calculation height to the height of the reference anemometer.
4. Update all calculations (right-click menu or press the F9 function key).
5. Select the Turbine site and go to Tools > Utility scripts menu.
6. Invoke the “Turbine site vertical profile (Excel)” script.

MS Excel will now start and show WAsP predictions for several levels between 5 and 100 m a.g.l. at the site of the mast:
Figure 18. Results of running the “Turbine site vertical profile (Excel)” script in WAsP are shown in MS Excel. The “All” column is the omni-directional wind profile; sector-wise wind profiles (here, 1-12) and power densities are also calculated.

Column A contains the height above ground level, column B the total (omni-directional) mean wind speed predicted by WAsP for the different heights. Columns C to N show the sector-wise wind speed profiles. The vertical profiles of power density are given below the wind speed profiles.

Plot columns A and B to obtain the wind speed profile graph; then plot the measured mean wind speeds from any other level at the mast with symbols, in order to compare the WAsP-predicted profile to the measurements, see Figure 18 below. Measurements at all levels should of course refer to the same period of time.

Figure 19. Measured and modelled vertical wind profiles at two sites in South Africa (data courtesy of the WASA project). The blue profile was modelled using the default setup of WAsP 11; the green profile is a strictly neutral (logarithmic) wind profile, and the red profile has been adapted to the local conditions by changing the heat flux values in WAsP slightly.
The wind speed profile graph may now be adjusted by adjusting the terrain descriptions, i.e. the roughness length map and the elevation map. If these are thought to be reliable, the wind profile can further be tweaked a bit by changing the heat flux values in the Profile model tab of the Generalised wind climate window. In Figure 18, the measured wind profile at mast WM05 is modelled well using the default heat flux values; whereas the measured wind profile at mast WM08 is much closer to neutral conditions. Here, the mean heat flux value was changed from −40 to −10 Wm⁻² in order to get a good model description of the observed wind profile.

Note, that the wind speed measurements will rarely fit exactly to the wind speed profile, partly because the lower levels will always be influenced by flow distortion from the mast itself. In order to avoid this, one could model the wind speed profile in certain sectors only, where flow distortion is expected to be small. However, in this case there is a risk that these data are not representative of the average, annual site conditions.

**Cross predictions between masts**

If wind speed and direction have been measured at two or more masts within the wind farm site – or in the region within which the generalised wind climate is assumed to be similar – it is possible to validate to what degree WAsP is able to model the wind speed variations across the wind farm site. This information may be used to adjust the terrain descriptions and (sometimes) the atmospheric stability settings in order to improve the WAsP modelling of the wind farm site.

The top anemometers are almost always used as reference levels. The procedure is then:

1. Make a WAsP project for each meteorological mast.
2. Insert all mast positions and heights as Turbine sites in the projects.
3. Use each mast to predict the wind climates at the other mast sites.
4. Make a table with the results of the cross prediction, e.g.:

<table>
<thead>
<tr>
<th>Site</th>
<th>01</th>
<th>06</th>
<th>07</th>
<th>08</th>
<th>09</th>
<th>10</th>
<th>Obs</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>4.2</td>
<td>3.4</td>
<td>3.3</td>
<td>4.1</td>
<td>4.4</td>
<td>4.5</td>
<td>4.3</td>
</tr>
<tr>
<td>06</td>
<td>5.6</td>
<td>4.6</td>
<td>4.4</td>
<td>5.7</td>
<td>6.1</td>
<td>6.3</td>
<td>5.7</td>
</tr>
<tr>
<td>07</td>
<td>6.5</td>
<td>5.5</td>
<td>5.3</td>
<td>6.9</td>
<td>7.2</td>
<td>7.4</td>
<td>5.4</td>
</tr>
<tr>
<td>08</td>
<td>6.9</td>
<td>5.2</td>
<td>4.8</td>
<td>6.2</td>
<td>6.8</td>
<td>7.2</td>
<td>6.2</td>
</tr>
<tr>
<td>09</td>
<td>5.8</td>
<td>4.6</td>
<td>4.4</td>
<td>5.7</td>
<td>6.1</td>
<td>6.4</td>
<td>6.1</td>
</tr>
<tr>
<td>10</td>
<td>5.6</td>
<td>4.4</td>
<td>4.1</td>
<td>5.2</td>
<td>5.5</td>
<td>5.6</td>
<td>5.7</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>0-10%</th>
<th>10-25%</th>
<th>25-40%</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Here, the reference sites (predictor sites) are given above each column and the predicted sites in each row. The right-most column contains the measured mean wind speeds. The ‘self-predictions’ are given in the diagonal; these should be close to the measured values. All of the observed wind climates should of course refer to the same period of time. The cross predictions may be improved by adjusting the terrain descriptions, i.e. the roughness length map and the elevation map. If these are thought to be reliable, the cross prediction results may further be tweaked a bit by changing the heat flux values in the generalised wind climate window. In complex (steep) terrain – as in the example above – the cross predictions may be significantly influenced by the ruggedness of the terrain. In such cases, a ruggedness index (RIX) analysis should be carried out and one might try to find the relation between prediction error and ΔRIX or, better yet, run WAsP CFD.
6.5 Special considerations

This section covers three special types of terrain, where some adjustment of the WAsP modelling is necessary or which violate the operational envelope of the WAsP models.

**Offshore**

Off-shore and near-shore conditions are generally within the operational envelope of the WAsP models, but there are a few special issues to take into account. First of all, the roughness length of the sea surface – like any other water surface in WAsP – should of course be set to 0.0 meters.

Secondly, for pre-WAsP-12 projects, the wake decay constant, \( k \), should be changed to offshore conditions; a value of \( k = 0.05 \) is recommended with Park 1. In WAsP 12, the setup of Park 2 is automatic, but it can be changed.

Because of the special foundations used for offshore meteorological masts and wind turbines, the height of the anemometer or wind turbine hub may be different from the nominal height of the mast or tower. In addition, many different vertical reference levels are used offshore. For WAsP modelling, the anemometer and wind turbine hub heights should be given in meters above mean sea level.

WAsP expects to encounter elevation or roughness change lines within 20 km from any site; for sites far offshore this may not occur and the model may throw an error. This can be remedied by changing the model interpolation radius in the project parameters or by adding a combined elevation/roughness change line around wind farm site itself.

There are no standard procedures for modelling of tidal flats or sea ice; in such cases it is recommended to study the effects through sensitivity analysis. The influence of air density and the heat flux values are treated in the same way as over land.

Referencing short-term measurements at an offshore site to the long-term climatology may be difficult because of the lack of nearby long-term stations. Here, different kinds of reanalysis data or numerical wind atlas data may be used.

The wake models in WAsP were not designed for very large offshore wind farms; the Fuga wake model is designed to handle such large arrays of wind turbines.

**Forested terrain**

WAsP does not contain specific models or procedures for modelling the wind flow in, above and around forests. Forests are simply specified in the vector map by roughness change lines. This works well when the forest is far away from the sites. If the meteorological mast or wind turbines are situated some distance within a forest, the effective modelling height (anemometer height or hub height) should be taken as the nominal height minus a displacement length. This displacement length – as well as the roughness length – is a function of the height of the trees and the stand density, but is often around 2/3 of the tree heights. Close to the forest edge, the flow may be quite complicated and WAsP cannot be expected to provide entirely reliable results.

**Steep terrain**

WAsP was originally designed for gentle and not too steep terrain, in which the wind can follow the terrain surface, i.e. where the flow is attached. In steep terrain, where flow separation occurs, the flow modelling results will be biased. Flow separation occurs when the terrain slopes are larger than about 30% (17°) on a downwind slope to about 40% (22°) on an upwind slope (Wood, 1995).
WAsP evaluates the steepness of the terrain using the so-called ruggedness index RIX (Bowen and Mortensen, 1995), which is defined as the fraction of the terrain around a given site steeper than a critical slope (default value 30%). Complex or steep terrain is then when RIX > 0 for one or more sites. Analyses at wind farm sites suggest that the prediction error is proportional to the difference in ruggedness indices between the predicted site (wind turbine) and the predictor site (meteorological mast), see Figure 19.

![Figure 20. WAsP wind speed prediction error in per cent as a function of the difference in ruggedness indices, \( \Delta RIX \) [%], between the predicted site and the predictor site. Data points represent cross-predictions between 5 masts in N Portugal.](image)

Qualitatively, WAsP will overestimate the mean wind speed significantly if the terrain around the predicted site (turbine site) has a larger fraction of steep slopes than the predictor site (met. mast). And, conversely, WAsP will underestimate the mean wind speed if the predicted site has a smaller fraction of steep slopes than the predictor. If the two sites are quite similar, the prediction errors seem to be small – even when both sites are characterised by large ruggedness indices, see Figure 19.

The relation between prediction error and difference in ruggedness indices has been used to correct WAsP predictions in steep and complex terrain, where \(|\Delta RIX|\) is larger than about 5% (Mortensen et al., 2006, 2008). Because of the empirical nature of the relation, this requires that the local slope of the fitted line in Figure 19 can be established; i.e. there must be two or more met. masts on the site. If \(|\Delta RIX|\) is smaller than 5%, the correction scheme is rarely used.

Access to computational fluid dynamics (CFD, EllipSys model) calculations has been implemented in WAsP, from version 11. It is strongly recommended to employ the CFD model in complex terrain; the RIX analysis will help determine when this is necessary.

### 7 Additional technical losses

The energy yield or AEP calculated by WAsP is the so-called potential annual energy production, which could potentially be produced by the wind farm when wake losses only have been taken into account. This, however, is not the production that will be fed into the electrical grid at the point of common coupling (PCC). Several additional (technical or operational) losses will occur between the wind turbine rotor(s) and the PCC, these losses are summarised in Table 1.
Table 1. Additional technical losses, which are not taken into account by WAsP, may be grouped into the following five categories (European Wind Energy Association, 2009). Typical values for an onshore wind farm in NW Europe are listed too. Range values from Brower et al. (2012) suggest that typical values may sometimes be too optimistic.

<table>
<thead>
<tr>
<th>Loss category</th>
<th>Technical loss type</th>
<th>Typical</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Availability</td>
<td>turbine availability</td>
<td>3%</td>
<td>2-10%</td>
</tr>
<tr>
<td></td>
<td>balance of plant availability</td>
<td>&lt; 1%</td>
<td>2-10%</td>
</tr>
<tr>
<td></td>
<td>grid availability</td>
<td>&lt; 1%</td>
<td></td>
</tr>
<tr>
<td>2 Electrical</td>
<td>operational electrical losses</td>
<td>1-2%</td>
<td>2-3%</td>
</tr>
<tr>
<td></td>
<td>wind farm consumption</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 Turbine performance</td>
<td>power curve adjustments</td>
<td>1-2%</td>
<td>0-5%</td>
</tr>
<tr>
<td></td>
<td>high-wind hysteresis</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>control losses (SCADA)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 Environmental</td>
<td>blade degradation and fouling</td>
<td>1-2%</td>
<td>1-6%</td>
</tr>
<tr>
<td></td>
<td>degradation due to icing</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>high and low temperature</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5 Curtailments</td>
<td>wind sector management</td>
<td>Design</td>
<td>0-5%</td>
</tr>
<tr>
<td></td>
<td>grid curtailment</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>noise, visual and environmental</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The losses must be estimated for each project and subtracted from the AEP calculated by WAsP, in order to obtain the metered production at the PCC. Because the losses are given as a fraction of the WAsP result, these need to be factored together as efficiencies. The additional losses vary greatly, but are often about 5-10% of the WAsP AEP in total. Therefore, it is paramount to know which production statistic is being used for a WAsP validation study. For most analyses, the production fed into the electrical grid should be used; this is our best estimate of the AEP or the so-called $P_{50}$ value.

Now that all the steps in the prediction procedure (using WAsP) have been described, it might be a good idea to revisit Section 1.4 and Figure 6. WAsP does not provide a result for each and every step automatically, but such results can of course be calculated or derived. What WAsP does provide directly is then:

- Site wind climates – the observed, generalised and predicted wind climates
- Wind farm gross yield – the ‘WAsP gross’ annual energy production
- Wind farm potential yield – the ‘WAsP net’ annual energy production

8 Modelling error and uncertainty

The difference between a WAsP prediction and the correct value is the modelling error. In general, the correct (or reference) value is not known exactly, even when predicting another cup anemometer or a wind turbine, where the wind speed or yield have been measured. This is because these numbers are also determined with some uncertainty. However, such measurements are likely close estimates of the reference values.

The modelling uncertainty (or precision) should always be estimated. The uncertainty is an estimate of the likely distribution of the modelling errors, and it is composed of all the uncertainties related to the entire assessment procedure. The different uncertainty factors tend to be random in nature and are often not correlated. In addition, the modelling
results may be biased. The bias (or trueness) represents any systematic deviation of the modelling result from the reference value. Any biases should be estimated and possibly corrected for. Figure 20 illustrates the meaning of uncertainty, precision, and trueness (bias); accurate estimates then have low uncertainty and trueness values.

![Diagram showing the concept of uncertainty, precision, and trueness](image)

**Figure 21. Modelling uncertainty and bias.** The ‘Mean value’ might correspond to the WAsP prediction (P50); the ‘Reference’ is the correct value we are trying to predict. The standard deviation of the normal distribution shown is 10% and the bias shown is 20%.

The normal distribution shown in Figure 21 can be plotted to show the exceedance probability as a function of the annual energy production, see Figure 22.

![Exceedance probability curve](image)

**Figure 22. Exceedance probability curve corresponding to the normal distribution shown in Figure 20.** The P50 value corresponds to the mean value in Figure 20.

Also shown in Figure 22 are the P90, P75 and P50 values, which correspond to exceedance probabilities of 90%, 75% and 50%, respectively. Different standard deviations of the normal distribution (different uncertainty estimates) will result in different exceedance curves. With a large standard deviation (uncertainty), the differences between the P90, P75 and P50 values become large; with a small standard deviation the differences will be small, see Figure 23.
Figure 23. Exceedance probability curves corresponding to normal distributions with different standard deviations: 20, 15, 10, 5 and 3%, respectively. The steeper the central part of the curve, the smaller the standard deviation. The $P_{90}$ values are indicated too.

8.1 Prediction biases

There are many examples of possible biases in a WAsP prediction, but they may be small and difficult to estimate and are often treated as simply adding to the uncertainty. As an example, mean wind speeds measured with a cup anemometer are inherently biased because of the behaviour of the instrument in a turbulent flow; however, these turbulent biases are often treated as just part of the overall measurement uncertainty.

Large biases can occur in complex (steep) terrain where $|\Delta RIX|$ is larger than about 5%. Applying the IBZ model of WAsP in such terrain can lead to large biases depending on the $\Delta RIX$ values of the turbine sites. Here, the predictions should be corrected according to a RIX analysis or, better yet, the CFD model of WAsP should be used.

8.2 Sensitivity analysis

Sensitivity analysis (SA) is the study of how the variation (uncertainty) in the output of a mathematical model can be apportioned, qualitatively or quantitatively, to different sources of variation in the input of the model (Wikipedia, 2010). In other words, it is the process of systematically changing input data and parameters in the WAsP modelling in order to determine the effects of such changes on the output; which in this case is the estimated annual energy production (AEP) of a wind turbine or wind farm. Sensitivity analysis thus investigates the robustness and uncertainty of the microscale modelling.

Table 2 shows results for a sample WAsP calculation in NE China: The changes in the predicted AEP at 75, 100 and 125 m a.g.l. when changing the inputs to the modelling. In this case, the uncertainty was minimised by using calibrated anemometers, adapting the wind atlas heights, adjusting the heat flux values, and adding details to the SRTM map.

It may not be necessary or even possible to study the sensitivity in a systematic way as described above; however, one should always try to identify which factors or parameters contribute most to the sensitivity of a modelling result.
Table 2. Comprehensive sensitivity analyses for a 70-m mast on a hill in Northern China.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Input change</th>
<th>Change in predicted AEP @ h</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>75 m</td>
</tr>
<tr>
<td>$U$ calibration</td>
<td>+1%</td>
<td>1.5%</td>
</tr>
<tr>
<td>Anemometer height</td>
<td>−1%</td>
<td>0.3%</td>
</tr>
<tr>
<td>Adapted atlas heights</td>
<td>standard → h</td>
<td>0.9%</td>
</tr>
<tr>
<td>Direction offset</td>
<td>+10°</td>
<td>0.7%</td>
</tr>
<tr>
<td>Air density</td>
<td>−2.5%</td>
<td>−1.4%</td>
</tr>
<tr>
<td>Stability</td>
<td>→ neutral</td>
<td>−1.4%</td>
</tr>
<tr>
<td>Heat flux</td>
<td>+10 Wm$^{-2}$</td>
<td>0.2%</td>
</tr>
<tr>
<td>BG roughness</td>
<td>half of 5 cm</td>
<td>0.4%</td>
</tr>
<tr>
<td>BG roughness</td>
<td>double of 5 cm</td>
<td>0.0%</td>
</tr>
<tr>
<td>Position of mast</td>
<td>±10 m</td>
<td>0.2%</td>
</tr>
<tr>
<td>Elevation detail</td>
<td>SRTM 3 only</td>
<td>−0.2%</td>
</tr>
</tbody>
</table>

8.3 Uncertainty estimation

The European Wind Energy Technology Platform (TPWind) has proposed a ‘3% vision’, stating that “current techniques must be improved so that, given the geographic coordinates of any wind farm (flat terrain, complex terrain or offshore, in a region covered by extensive data sets or largely unknown) predictions with an uncertainty of less than 3% can be made concerning the annual energy production and other wind conditions”. This 3% vision is illustrated in Figure 23.

Also shown in Figure 23 is the result of a WAsP validation study, where actual wind farm productions from 20 operating wind farms were compared to the original WAsP predictions. The numerical wind atlas (NWA) data are from the Wind Atlas for Egypt (Mortensen et al., 2005) and the CREYAP results from Mortensen et al. (2015).

Figure 24. Sample AEP distributions: TPWind goal for 2030, WAsP validation study of operating wind farms, numerical wind atlas study, and industry benchmark study.
Unlike the technical losses described above, the sources of uncertainty have not been classified in a similar systematic way. The EWEA Comparison of Resource and Energy Yield Assessment Procedures (Mortensen et al., 2012, 2015) show that a broad selection of significant players in the wind energy industry apply quite different classifications and evaluation practices. Some sources of uncertainty seem to be generally accepted, though the exact definition and calculation are not always clear. Commonly accepted sources of uncertainty are listed in Table 3; DNV KEMA (2013) has a slightly different table of uncertainty factors.

**Table 3. Commonly used sources of uncertainty by category and type.**

<table>
<thead>
<tr>
<th>Uncertainty category</th>
<th>Uncertainty type</th>
<th>Typical values</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Wind data</td>
<td>• wind measurements</td>
<td>2-5% on wind speed</td>
</tr>
<tr>
<td></td>
<td>• long-term extrapolation</td>
<td>1-3% on wind speed</td>
</tr>
<tr>
<td>2 Future wind variability</td>
<td>• inter-annual variability</td>
<td>2-6% on wind speed</td>
</tr>
<tr>
<td></td>
<td>• climate change</td>
<td>?</td>
</tr>
<tr>
<td>3 Spatial variation (flow modelling)</td>
<td>• vertical extrapolation</td>
<td>0-5% on wind speed</td>
</tr>
<tr>
<td></td>
<td>• horizontal extrapolation</td>
<td>0-5% on wind speed</td>
</tr>
<tr>
<td>4 Power conversion</td>
<td>• power curve</td>
<td>5-10% on AEP</td>
</tr>
<tr>
<td></td>
<td>• metering</td>
<td>0-2% on AEP</td>
</tr>
<tr>
<td>5 Plant performance and losses</td>
<td>• wake effects</td>
<td>0-5% on AEP</td>
</tr>
<tr>
<td></td>
<td>• technical losses</td>
<td>0-2% on AEP</td>
</tr>
<tr>
<td>6 Other</td>
<td>• air density</td>
<td>0-2% on AEP</td>
</tr>
</tbody>
</table>

Every wind farm yield assessment report should contain an estimation of the uncertainty of the energy yield estimation. The total uncertainty on the energy yield prediction is usually calculated by applying the equation for an independent stochastic process to combine the main uncertainties. Only the main uncertainties are estimated and these are assumed to be Gaussian distributed. With these assumptions, it is also possible to calculate the exceedance statistics, i.e. find yield levels with a certain probability of those levels being exceeded.

The aggregate uncertainty for the estimation of the yield of an onshore wind farm in Europe is often between 10 and 15% of AEP. An estimated uncertainty larger than 15% or lower than 10% should be highlighted and discussed.

### 9 Wind conditions and site assessment

WAsP can estimate the mean wind climate at all the sites in a wind farm – and anywhere else in the terrain. To estimate, say, the 50-y extreme wind speed and the turbulence intensity at the turbine sites in a wind farm takes a bit more. In this chapter, simple step-by-step introductions to WAsP Engineering and the Windfarm Assessment Tools are given, in order to derive the necessary results. Note, that the focus of course 46200 is on the principles of the IEC 61400-1 standard and not on the details of these two software packages.

One estimate of the 50-y extreme wind speed may be derived from the measurements at the meteorological mast: here, the Climate Analyst can provide the *observed extreme wind climate*. This can be obtained by right-clicking **Results** and choose **Create an Oewc**, see Figure 24.
Figure 25. Sample observed extreme wind climate from Sprogø 1977-99; single events in a polar representation to the left and the extreme wind speed distribution with a Gumbel fit to the right (data courtesy of Sund & Bælt). The 50-\(y\) extreme wind 70 m a.g.l. at this site is 32.9 m\(s^{-1}\), cf. Figure 7 for information on the mean wind climate.

The turbulence intensity can be calculated from the measurements of wind speed and standard deviation of wind speed, see Figure 25.

Figure 26. Observed turbulence intensities at a meteorological mast. The measurements have been binned in intervals of 1 m\(s^{-1}\); mean values and standard deviations of the turbulence intensities in each bin are shown.

However, if the mast is not at hub height or is situated in a terrain which is not similar to the terrain at the wind farm site, the observed extreme winds and turbulence intensities may not be representative of the turbine sites.

### 9.1 Extreme wind and turbulence intensity

It is possible to use WAsP Engineering to estimate the extreme winds and turbulence intensities at the turbine sites in a wind farm, without knowing every little detail of the software or models. See the WAsP Engineering help file for more information.

First, you need to make a few input files to WAsP Engineering. In the Climate Analyst, you need to calculate and save the observed extreme wind climate:
1. Right-click **Results** and choose **Create an Oewc**
2. Right-click the Oewc and **Export to file**... to an *.oewc file

In WAsP, you need to export the different site locations and the generalised wind climate to files:

1. Right-click the met. station and **Extract site location** to a *.wsg file
2. Right-click the wind farm and **Extract site locations** to a *.wsg file
3. Right-click the generalised wind climate and **Export to file**... choose type *.lib

In WAsP Engineering, you need to set up a project for the wind farm:

1. From the **File** menu, choose **Create new project**...
2. Select **Use Vector Map** and choose the WAsP vector map for the project setup
3. Provide the **latitude** and **select an area** for the project
4. Define the flow **domain structure** according to the recommendations given on the WAsP home page. (go to WEng > Working with maps in WEng).
5. Right-click the **Sites** member and choose **Insert site locations from file**
6. Insert the met. station and the wind farm turbine sites in this way. The calculation height(s) of the sites should now be shown in the **Heights** pane.
7. From the **Insert** menu, choose **Observed extreme wind climate from file**...
   Select the *.oewc file that was exported from the Climate Analyst. And provide the met. mast coordinates.

Now, the basic WAsP Engineering project has been set up and you can do some calculations. For example, to estimate the extreme winds at the sites, do the following:

1. Right-click the parent object of the met. station (Winds) and choose **Calculate a generalised extreme wind climate**. NB: This may be a lengthy calculation.
2. Left-click your wind farm, hub height and generalised extreme wind climate in the hierarchy in order to select objects for further calculation.
3. In the **Tools** menu, choose **Scripts** and then **Applied EWC report: 50 y winds for all sites and heights**.

Check the results in the MS Word file that opens; this will give you information about the 50-y extreme winds at the sites.

### 9.2 IEC site assessment

To make a full IEC 61400-1 site assessment, a combination of WAsP and WAsP Engineering results need to be post-processed in the **Wind farm Assessment Tool** (WAT):

1. Left-click a group of turbines, the hub height of these turbines and the regional extreme wind climate in the hierarchy in order to select these for calculation.
2. In the **Tools** menu, choose **Prepare data for WAT**
3. Select the *.lib file you exported from WAsP
4. Select the appropriate wind turbine generator file (*.wtg or *.pow)

---

1) You can speed up extreme wind calculations in two ways: 1) Press **Edit | Project settings | Climate calculations** and modify the interpolation scheme, or 2) press **Edit | Re-define project domain** and reduce the flow model domain. Consider your choices carefully as the need for detail depends on the terrain.
5. Choose **Display the results in Excel** and press **OK**

Check the results in the MS Excel file that opens; this will contain information about the 50-y extreme wind speed, terrain inclination, wind rose, Weibull $A$- and $k$-parameters, speed-up factor, wind direction deflection, wind shear exponent ($\alpha$), turbulence intensity ($u$, $v$, and $w$ components), standard deviation of wind speed and flow angle.

**Windfarm Assessment Tool (WAT)**

The WAT tool is needed to estimate the effective turbulence intensity:

1. In WAsP Engineering, right-click **Terrain Maps** | **Elevation grid** and **Export the grid map to file**; choose the Surfer grid format (*.grd).
2. Save and close the Excel Workbook mentioned above.
3. Open WAT and select **File** | **New** | **Import WAsP/WEng data** to import data from the Excel Workbook and the wind turbine generator file.
4. Select turbine class and turbulence category according to the turbine certificate.
5. Select **Edit** | **Add Terrain data** and load the Surfer file.
6. Select an appropriate Wöhler exponent for the weakest part of the turbine, typically $m = 10$ for glass fibre blades.
7. Select **Wind farm overview** | **Flow conditions** and check whether all turbine sites obey the IEC 61400-1 site assessment rules. Select individual sites using the tab **Reports for selected site** to investigate specific problems.
8. Browse the WAT help file from **Help** | **Help file** to find out more

The WAT tool can also be used for wind farm technical loss and uncertainty estimations.

**References**


---

2) For a complex wind farm with more than one turbine type you can 1) organize the WAsP Engineering project in groups with similar turbines, 2) prepare WAT data for each group and hub height, and 3) import and merge group results in WAT.


Other resources


IEC 61400: Wind turbine generator systems.

Wind Atlases of the World web site: www.wasp.dk/dataandtools#wind-atlas

Wind Atlas for South Africa download site: wasadata.csir.co.za/wasa1/WASADa

Course software
The course software can be downloaded from the WAsP web site: download the file WAsPSuite-2018-12-21-A.exe or newer and install. This file contains:

- WAsP 12.2.14
- WAsP Map Editor 12.2.8.49
- WAsP Climate Analyst 3.1.43
- WAsP Engineering 4.0.176
- Windfarm Assessment Tool 4.4.155

Acknowledgements
WAsP software is developed and maintained by a team of scientists, software designers, programmers, and technical support staff at DTU Wind Energy and World in a Box Oy. Without this team effort there would be no software, no training courses and no course notes like these. The help and support of the WAsP team are gratefully acknowledged; Morten Nielsen specifically helped with the procedures in Section 9.
A WAsP best practice and checklist

This list of requirements, best practices and recommendations is not exhaustive, but is meant to provide a brief summary of some important considerations regarding WAsP modelling. More information is available in the WAsP help system and at www.wasp.dk.

Measurement programme
- Design measurement programme based on preliminary WAsP analysis
  - Use SRTM elevation and water body data + land cover from GE or database
- Follow WAsP similarity principle as much as possible when siting the mast(s)
- Height of reference anemometer(s) similar to hub height (preferably > 2/3 $h_{hub}$)
- Optimum boom direction is oriented @ 90° (lattice mast) or @ 45° (tubular mast) to the prevailing wind direction.
- Deploy 2 or more masts for validation of horizontal extrapolation
- Deploy 2 or more masts if RIX and $\Delta$RIX analyses are required
- Deploy 2 or more levels on masts for wind profile analyses and validation
- Deploy 2 or more levels on masts for redundancy in instrumentation
- Measure temperature (@ hub height) and pressure for air density calculations
- Are anemometers individually calibrated according to international standards?
- Are wind vanes calibrated & alignment validated when mounted on the mast?

Wind data analysis
- Collect required information, e.g. by filling out a WAsP Data Description Form
- All fields in Climate Analyst should correspond to project and data spec's
- Plot and inspect time traces of all meteorological measurements + statistics
- Visual inspection of time-series – in particular reference wind speed and dir’n
- Visual inspection of polar scatter plot – any noticeable patterns or gaps?

Observed wind climate
- Use number of whole years when calculating the OWC and export as OMWC
- Check Weibull fit: is mean wind power density discrepancy < 1%?
- Check Weibull fit: is mean wind speed discrepancy < a few per cent?
- Check within context of long-term wind climate (MCP or similar)

Elevation map(s)
- Size of map: should extend at least several (2-3) times the horizontal scale of significant terrain features from any site – meteorological mast, reference site, wind turbine site or resource grid point. This is typically 5-10 km.
- Coordinates and elevations must be in meters. Elevations should be a.s.l.
- Set map projection and datum in the Map Editor and embed in map file
- Add spot heights within wind farm site; or interpolate contours if necessary
- High-resolution contours around calculation sites: contour interval ≤ 10 m
- Lower-resolution contours away from calculation sites: contour interval ≥ 10 m
- Non-rectangular maps are allowed (circular, elliptic, etc.)
- Check range of elevations and contour interval in final map

Roughness/land cover map(s)
- Size: map should extend to at least max(150×$h$, 10 km) from any site – meteorological mast, reference site, turbine site or resource grid point.
- Coordinates and roughness lengths must be in meters
- Set map projection and datum in the Map Editor and embed in mapfile
Set roughness length of water surfaces to 0.0 m!
Check range of roughness length values in final map
Map date should correspond to modelling scenario: meteorological mast (past) or wind farm (present and future) – use two maps in hierarchy if necessary.
Check for dead ends and cross points – and edit map as needed
Check consistency of roughness values – there must be no LFR-errors!

Sheltering obstacles
- Is site closer to obstacle than 50 obstacle heights and height lower than about 3 obstacle heights?
- If yes to both, treat as sheltering obstacle; if not, treat as roughness element

WAsP modelling – site visit
- Go on a site visit! Use e.g. the WAsP Site/Station Inspection checklists
- Print and bring the WAsP forms for recording the necessary information
- Bring GPS and check projection and datum settings – change if required
- Determine coordinates of all masts, sites, landmarks and other points on site.
- Bring sighting compass to determine boom directions and mast installation
- Check wind vane calibration; including magnetic declination and convergence
- Bring laser distance meter to determine anemometer and sensor heights a.g.l.
- Take photos of station and surroundings (12 × 30°-sector panorama)
- Take photos of typical land cover classes and terrain features
- Determine GPS position of mast on every visit and average positions

WAsP modelling – parameters
- Wind atlas (GWC) structure: roughness classes should span and represent the site conditions. A water class should always be present in the GWC
- Wind atlas (GWC) structure: standard heights should span and represent the project conditions: mast height and prediction heights.
- Ambient climate: Set air density to site-specific value (pre WAsP 12 only)
- Activate model for geostrophic wind shear (WAsP 12 and later only)
- Adjust off- & on-shore mean heat fluxes values to site conditions (caution!)

WAsP modelling – analysis and application
- Get site-specific (density, noise ...) wind turbine generator data from the wind turbine manufacturer, and select an appropriate air density correction policy.
- Within forest: effective height = {nominal height} minus {displacement length}
- Complex or steep terrain is when RIX > 0 for one or more sites (terrain slope angles > 17° or 30%).
- Make RIX and ΔRIX analyses if RIX > 0 for any site – but use WAsP CFD too!

WAsP modelling – offshore
- Roughness length of sea (and other water) surfaces: set to 0.0 m in WAsP!
- Add combined elevation/roughness change line (0, 0, 0) around wind farm site
- Change (pre WAsP 12) or check wake decay constant(s) for offshore conditions

WAsP modelling – sensitivity analyses and uncertainties
- Determine sensitivity of results to background roughness value and other important modelling parameters.
- Identify and try to estimate the magnitude of the main uncertainties
- Estimate technical losses and uncertainty for calculation of net yields ($P_{50}$ and $P_x$) @ point of common coupling (PCC).
B Note on the use of SAGA GIS

The WAsP Map Editor supports direct import of SRTM elevation and coastline data and some raster land cover data; therefore it is **not** necessary to use SAGA GIS (or similar software) for this task. However, this GIS tool may still come in handy for processing other elevation or land cover data sets in grid format. This section contains a brief guide to making elevation vector maps, using the SRTM data as an example.

SAGA (System for Automated Geo-scientific Analyses) is a GIS system developed by University of Göttingen (Conrad *et al.*, 2015); the home page is [www.saga-gis.org](http://www.saga-gis.org). SAGA GIS can be used to make WAsP height contour (vector) maps from different kinds of gridded (raster) data. SAGA is a Free Open Source Software (FOSS).

Processing an SRTM grid for WAsP use

SRTM elevation data can be downloaded from [dds.cr.usgs.gov/srtm/](http://dds.cr.usgs.gov/srtm/) (version 2.1) or [e4ftl01.cr.usgs.gov/SRTM/](http://e4ftl01.cr.usgs.gov/SRTM/) (version 3, requires login). Once you have downloaded and unzipped a 1°×1° tile, import the grid from the **Geoprocessing** menu:

Left-click in the white field next to **Files** and enter or select the grid file name (*.hgt):

Make the height contours from the **Geoprocessing** menu, selecting the range and height contour interval:
Set the grid system and contour interval in the **Contour Lines from Grid** window:

The **Data** workspace (**Tree view**) should now look something like this:

where the **Grids** section contains the SRTM grid and the **Shapes** section the contour lines. Double-click the grid, e.g. “01. N55E012”, to display it – same goes for the Shape “01. N55E012”. The **Maps** workspace could look something like this:

Finally, export the contours to a WAsP terrain map file from the **Geoprocessing** menu:

Each SRTM3 grid file covers a $1^\circ \times 1^\circ$ tile and contains $1201 \times 1201$ cells; an SRTM1 grid file also covers a $1^\circ \times 1^\circ$ tile, but contains $3601 \times 3601$ cells. This is sometimes too much information too process or too large an area. The imported SRTM grid can be trimmed from the **Geoprocessing** menu:

First, show the grid in a **Map** window. Next, start the **Clip Grids** [interactive] tool, select the grid system and grid and click **Okay**. Next, select the **Action** pointer (the black arrow) in the toolbar:
In the Map window, drag out (left click and drag) the approximate area for the sub-grid that you would like to extract. A Clip to Extent window now pops up:

![Clip to Extent window](image)

The sub-grid configuration may be edited further here. Press Okay to continue. The Data workspace should now look something like this:

![Data workspace](image)

New (sub)grid can be contoured and exported as a WAsP map file as described above.

![WAsP map file](image)

The coordinates of the exported WAsP map file are geographical latitude and longitude; these must be transformed to a metric coordinate system in the WAsP Map Editor:

1. **Open** the map in the Map Editor.
2. Click Yes to switch to geographic Lat-Lon coordinate system, and then Ok twice.
3. Next, select **Tools > Transform > Projection**.
4. Select **Global Projections > UTM projection** for the Projection Type.
5. Leave Datum as WGS 1984 (or change to other) global/local datum.
6. Press Ok to transform the map coordinates.
Processing an SWBD shape file separately

The SRTM Water Body Data (SWBD) set contains coastlines, lakes, and rivers in SHP format. When importing SRTM elevation data through the File > Import from database > SRTM maps in the Map Editor, the relevant coastlines, lakes and rivers will be downloaded as well. However, this information can also be downloaded separately from dds.cr.usgs.gov/srtm/version2_1/SWBD/. SAGA GIS can read such files, and so can the WAsP Map Editor.

Once you have downloaded and unzipped a 1°×1° tile, import the SHP file from the Map Editors File > Import > ESRI shape file maps. Note that the SWBD data contain lines along the tile boundaries; these lines are artefacts of the data set and have to be removed. The coastlines in a vector map should just end at the border of the map.

Bathymetry data

ETOPO1 is a 1 arc-minute global relief model of Earth's surface that integrates land topography and ocean bathymetry. It was built from numerous global and regional data sets, and is available in "Ice Surface" (top of Antarctic and Greenland ice sheets) and "Bedrock" (base of the ice sheets) versions. Historic ETOPO2v2 and ETOPO5 global relief grids are deprecated but still available. See National Centers for Environmental Information web site.

The General Bathymetric Chart of the Oceans (GEBCO) is made up of an international group of experts in ocean mapping. They develop and make available bathymetric data sets and data products, see Gebco 2014.

The EMODnet Bathymetry portal is being developed by a European partnership. The partners combine expertise and experience of collecting, processing, and managing of bathymetric data together with expertise in distributed data infrastructure development and operation and providing OGC services (WMS, WFS, and WCS) for viewing and distribution, see Portal for Bathymetry.
C Digitisation of the land cover (roughness) map

The land cover (roughness length) map can be digitised from a scanned paper map, aerial photograph or satellite imagery as described in the Map Editor Help file. However, there are a few other options; these are described below.

Digitising lines directly in Google Earth

You can also digitise roughness change lines directly in Google Earth (GE):

1. Un-tick the Layers | Terrain feature in Google Earth so the terrain appears flat
2. Make a folder in the GE hierarchy to contain the roughness change lines
3. Right-click on this folder and select the Add part of the menu
4. Select Path (polyline) or Polygon (polygon, i.e. a closed line)
5. Start digitising the first land cover / roughness change line
6. Continue digitising land cover / roughness change lines
7. When done, right-click the folder and choose Save Place As...
8. Choose the GE *.kml (or *.kmz) format and save the roughness lines to a file

The kml / kmz file can now be imported directly into the Map Editor (File > Import):

1. First, Import the kml / kmz file
2. Change coordinate system in Tools | Transform | Projection from geographic to metric of choice.
3. Show the map graphic and set the properties for each line; several lines can be selected (left-click, Ctrl+left-click ...) and changed in one operation.
4. Finally, Save or Save As the WAsP *.map file

Importing Google Earth imagery into WAsP and the Map Editor

Google Earth (GE) images can be imported into WAsP and the Map Editor:

1. Insert a Terrain analysis / Vector map into the WAsP hierarchy
2. Show the vector map in a new spatial view
3. Click the Synchronise view with virtual globe (GE) icon
4. Click the Frame current view in virtual globe icon (four purple markers)
5. Go to GE where four purple markers have now been inserted in the image (zoom out a bit if you cannot see them)
6. Select Edit and Copy Image in GE
7. Go back to WAsP
8. Right-click the vector map and select Insert spatial image from clipboard...
9. Click the Show or hide spatial images in the Spatial View window

The GE image can now be seen in the spatial view of WAsP. To use it in the Map Editor:

1. Right-click the spatial image in the hierarchy and select Export to file...
2. Save the image to disk file. A scaling file is saved automatically as well
3. This image is saved with scaling information and can now be loaded as a background map in the Map Editor.
D The Global Wind Atlas

As described above, topographical information for WAsP modelling is available and can be downloaded from the internet. A similar development is now taking place for wind-climatological information. Different reanalysis data sets have been available for some time, but in coarse spatial resolutions. In 2015, DTU published the first global, high-resolution wind climate data set accounting for high-resolution topographical effects.

Figure 27. The Global Wind Atlas 1.0 web interface provided by DTU Wind Energy.

The Global Wind Atlas 1.0 data sets and web tools were designed for aggregation, upscaling analysis and energy integration modelling for energy planners and policy makers. It is therefore not correct to use the data and tools for detailed wind farm siting and wind farm energy yield assessments. However, the data may be used for project preparation, design of the measurement campaign and similar; WAsP-compatible generalised wind climate files (*.lib) can be downloaded anywhere in the world.

In 2017, version 2 of the Global Wind Atlas was published by the World Bank and DTU.

Figure 28. The Global Wind Atlas 2.0 web interface provided by the World Bank.
DTU Wind Energy is a department of the Technical University of Denmark with a unique integration of research, education, innovation and public/private sector consulting in the field of wind energy. Our activities develop new opportunities and technology for the global and Danish exploitation of wind energy. Research focuses on key technical-scientific fields, which are central for the development, innovation and use of wind energy and provides the basis for advanced education at the education.

We have more than 240 staff members of which approximately 60 are PhD students. Research is conducted within nine research programmes organized into three main topics: Wind energy systems, Wind turbine technology and Basics for wind energy.